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FirstButton™ Documentation 
 

Permission is granted to copy, distribute and/or modify this document under the terms of the Creative 
Commons Attribution-ShareAlike 3.0 license. 
(Visit https://creativecommons.org/licenses/by-sa/3.0/ for more information.) 

 
Note: In order to avoid a potential Program Compatibility Assistant message in Windows Vista or Windows 7, FirstButton 
was recompiled using Visual Studio 2010, which allows for the inclusion of a compatibility section in the application 
manifest.  Please see page 8 for more information. 

  
The original program was compiled using Visual Studio 2005.  VS 2005 was also used to add the 6 custom 
icons to the executable (a process described in this document.) 
 

The sample package includes: 
  logoinst.sln  logoinst.suo  logoinst.vbproj  logoinst.vbproj.user  registry helpers.vb  Resource1.Designer.vb  
Resource1.resx    tgt_inst.Designer.vb  tgt_inst.resx  tgt_inst.vb  tgt_license.Designer.vb  tgt_license.resx  tgt_license.vb  
AssemblyInfo.vb    

 
The licensing screen has a large amount of information unique to Liquidity Lighthouse, LLC, and thus has not 
been included.  It is highly recommended that a similar screen be built to require user agreement to the Free 
Software Foundation’s license, before allowing installation to continue. 
 
Required .NET Framework component libraries for compilation: 
These are not distributed with this component, and are not part of the Licensing of FirstButton™ Source Code, 
but are needed for successful program compilation with Visual Studio.  If backward compatibility to Windows 98 
is desired, older versions of the components such as 2.0.0.0 should be used. 
 Reference Name          DLL        Version 
 Microsoft.VisualBasic.Compatibility   Microsoft.VisualBasic.Compatibility.dll 8.0.0.0 
 System          System.dll      2.0.0.0 
 System.Data          System.Data.dll     2.0.0.0 
 System.Drawing         System.Drawing.dll    2.0.0.0 
 System.Windows.Forms        System.Windows.Forms.dll   2.0.0.0 
 System.Xml          System.Xml.dll     2.0.0.0 
 

Variables 
These variables are defined in the tgt_inst_Load Private Sub of the FirstButton program tgt_inst.vb, and are 
used throughout the code to define important values used in the Toolbar Button. 
logo_new_guid  (String)  If logo_install_tools = true, then a unique GUID for Windows to use for your Tools Menu 

extension is required here.  Include beginning and ending brackets that are generated by guidgen.exe. 
                        Example: logo_new_guid = "{1E796980-9CC5-11D1-A83F-00C04FC99D61}" 

Remember to generate new GUIDs using GUIDGEN for your own code modifications! 
 
logo_new_guid_2  (String)  Required. This should be set to a unique GUID for Windows to use when building a Toolbar 

Button based on the information in the FirstButton installer.  This GUID value must be unique.  Do not reuse 
the same GUID as in logo_new_guid. 

  Remember to generate new GUIDs using GUIDGEN for your own code modifications! 
 
logo_brand_name  (String)   Your Brand Name that appears on the InfoTip for the Toolbar Button. 
 
logo_company_name  ( String)  Your company's name.  Example: logo_company_name = "Example, LLC"  
 
logo_company_url   (String)  Your company's website url that clicking on the Toolbar Button should direct the browser to 

example: www.exampleco.com 
  

https://creativecommons.org/licenses/by-sa/3.0/
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logo_default_target_pos  (Integer)  For IE6: position on toolbar (relative) where the Toolbar Button should appear.   
Setting this value to 0 will place your Toolbar Button Left of the first currently appearing button on the user's 
IE toolbar. 

Setting it to 1 will place it to the right of the first currently appearing button on the Toolbar. 
 
logo_IE7_default_target_pos  (Integer)  For IE7, IE8, IE9, IE10, and IE11: position on the toolbar (relative) where the 

Toolbar Button should appear. 
  Setting this value to 0 will place your toolbar Button left of the first currently appearing button on the user's 

IE toolbar.  
  Setting it to 1 will place it to the right of the first currently appearing button on the Toolbar. 
 
logo_IE7_use_mapid_logic  (Boolean)  For IE7, IE8, IE9, IE10, and IE11: when a non-microsoft button appears ahead of 
the default target position, 

If this value is set to 'true', then FirstButton will install your button 1 position to the left of that button, rather 
than at the default target position, so that it appears ahead of any other buttons. 

 
logo_use_mapid_logic  (Boolean)  For IE6: when a non-microsoft button appears ahead of the default target position, if 

this value is set to 'true', then FirstButton will install your button 1 position to the left of that button, rather than 
at the default target position, so that it appears ahead of any other buttons. 

 
logo_install_favorite  ( Boolean)    When set to 'true', FirstButton will add a Favorites Link for your website, using the .exe 

installer file as a graphics source.  The URL information will be used from logo_company_url. 
 
logo_install_tools   (Boolean)    When set to 'true', FirstButton will add a Tools Menu link for your website, using the URL 

information from logo_company_url. 
 

Icons 
In the FirstButton Source Code, there are lines such as the following which are added to the registry, to direct 
Internet Explorer to the appropriate Icon size and graphics.  The following is an explanation of the Icon number 
assignments and meanings: 

 

(logo_app_path & logo_install_module & ",1")) 

 

(Windows includes the numbers as part of the string designating the location of the icon for Internet Explorer). 
All of the below .ico files contain multiple icons, sized at 16x16, 20x20, 24x24, 32x32, and 48x48. 

 
1  For IE7, IE8, IE9, IE10, IE11 (desktop mode), this value is used for HotIcon and Icon sources 
   For IE6, on Windows XP, this is used for Icon value for Toolbar Button (256 colors) 

      (contains icon sizes 16x16, 20x20, 24x24, 32x32, 48x48)   
 
2  For IE6, on Windows XP, this is used for HotIcon value for Toolbar Button  (256 colors, but grey toned) 

    (contains icon sizes 16x16, 20x20, 24x24, 32x32, 48x48)   
 
3  For Windows 2000, IE 5.5 or 6, this is used for Icon  (256 colors, suitable to IE6) 

    (contains icon sizes 16x16, 20x20, 24x24, 32x32)   
 
4  For Windows 2000, IE 5.5 or 6, this is used for HotIcon  [Mouse is over Toolbar Button]  

 (256 colors, but grey toned) 

    (contains icon sizes 16x16, 20x20, 24x24, 32x32)   
 
5  For Windows 98, Me, or NT, this is used for Icon value for Toolbar Button  (16 colors) 

    (contains icon sizes 16x16, 20x20, 24x24, 32x32)   
 
6  For Windows 98, Me, or NT, this is used for HotIcon [Mouse is over Toolbar Button]  

 (16 colors, but grey toned) 

    (contains icon sizes 16x16, 20x20, 24x24, 32x32)   
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Process for customizing the FirstButton™ Source Code for your own Toolbar Button 

 

- With all program components in a single Windows folder, open logoinst.sln with Visual Studio 2005 (or 

a more recent version.) 

- Use GUIDGEN.exe to generate 2 unique GUIDs {########-####-####-####-############} using the 

Registry Format option.  One GUID will be used in the tgt_inst.frm source code for the toolbar button, 

and another for the tools menu extension. 

The default location for GUIDGEN.exe when VS 2005 is installed, is C:\Program Files\Microsoft Visual 

Studio 8\Common7\Tools\GUIDGEN.exe 

Instructions for using GUIDGEN can be found at http://msdn.microsoft.com/en-

us/library/ms241442(v=vs.80).aspx   

In my experience , GUIDGEN had to be added manually to the Tools menu options: 

Select the Tools Menu, then External Tools, to open the External Tools box. Click on ‘Add’, and provide 

a meaningful Menu option title such as “GUIDgenerator”, and point the Command to C:\Program 

Files\Microsoft Visual Studio 8\Common7\Tools\GUIDGEN.exe, or the location of GUIDGEN.exe on 

your computer. 

 

 
 

GUIDGEN.exe can also be run outside of Visual Studio, by doublie-clicking the utility in Windows 

Explorer. 

 

- Locate these values in the tgt_inst_Load section, and replace the existing GUIDs with those that 

were just generated by GUIDGEN: 

 logo_new_guid = "{DED51647-3FFD-48da-9B48-814A053F6388}" <- copy your 1st 

GUIDGEN value here 
 logo_new_guid_2 = "{D294CEA5-4017-4cb1-8B95-054C4A2FB2AE}" <- copy your 2nd 

GUIDGEN value here 

 

http://msdn.microsoft.com/en-us/library/ms241442(v=vs.80).aspx
http://msdn.microsoft.com/en-us/library/ms241442(v=vs.80).aspx
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- Replace the icon for tgt_inst.frm and tgt_license.frm with one for your personal brand.  This should be a 

.ico file containing icon sizes of 16x16, 20x20, 24x24, 32x32, and 48x48.  The icon #1 from the Icons 

section can be used for the tgt_inst.vb Icon definition.  

 
 

- Select a unique program name for your installation module, such as sample.exe.  Update the 
logo_install_module variable with “sample.exe”, logo_install_module_2 with “sample[1].exe”, and 
logo_install_module_3 with “sample[2].exe”, where sample is the name of your program.  The .exe 
extension is required in this context, since all of the required Icons are self-contained within the 
installation module itself.   

 logo_company_name = "[your company name goes here]" 

    logo_brand_name = "[your company or brand name goes here]" 

    logo_company_url = "[your company URL or target URL for the toolbar button]" 

    logo_new_guid = "[GUID for your Tools menu extension]" 

    logo_new_guid_2 = "[GUID for your Toolbar Button]" 

    logo_install_module = "sombreros.exe" 

    logo_install_module2 = "sombreros[1].exe" 

    logo_install_module3 = "sombreros[2].exe" 

    logo_IE7_install_guid = "N"          (initial setting, should remain as ‘N’) 

    logo_IE7_install_guid_2 = "N"        (initial setting, should remain as ‘N’) 

    logo_install_guid = "N"              (initial setting, should remain as ‘N’) 

    logo_install_guid_2 = "N"            (initial setting, should remain as ‘N’) 

    logo_toolbar_cmdmap_exists = "N"     (initial setting, should remain as ‘N’) 

    logo_button_installed = False        (initial setting, should remain as ‘False’) 

    logo_default_toolbar_built = False   (initial setting, should remain as ‘False’) 

    logo_toolbar_prev_install = False    (initial setting, should remain as ‘False’) 

    logo_default_target_pos = 2          toolbar position where IE6 will insert your Toolbar Button 

    logo_IE7_default_target_pos = 2      toolbar position where IE7-IE10 will insert your Toolbar Button 

    logo_IE7_use_mapid_logic = True        see description in Variables section 

    logo_IE7_allow_multi_installs = False  see description in Variables section 

    logo_use_mapid_logic = True            see description in Variables section 

    logo_allow_multi_installs = False    Keep as ‘False’ – IE does not handle multiple installs well 

    logo_install_tools = True            If installation of Tools Menu Extensions is needed, set to ‘True’ 

    logo_install_favorite = True         If installation of Favorites Menu Item is needed, set to ‘True’ 

    logo_install_add_remove = True       Recommended to keep set to ‘True’. Otherwise, Control Panel 

item for uninstallation of your Toolbar Button will not be 

available to the user. 
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To import Icon variations: 

1) Launch Visual Studio 

 

2) From the File Menu, select ‘Open File’. 

In the File Open box, select the executable you compiled, such as “sample.exe”. 

 

For the example screen prints, I have included ‘sombreros.exe’. 

 

 
3) With sombreros.exe highlighted, select ‘Add Resource’ from the Edit Menu. 

 

From the Resource types available, select Icon, and click on Import 

 

 
 

A file open box will appear.  Direct the box to the folder location of your custom icons. 

Type *.ico for the filename, and hit enter, to show only the icon files that are available. 
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Select the first icon, in our example it is ‘001.ico’, and click on ‘Open’ to import the file into the executable. 

After the icon has been imported, it will display in Visual Studio.  Click on the ‘sombreros.exe’ tab next: 

 

 
 

The file icon number ‘101’ should be associated with the icon file we just imported. 

With ‘101’ highlighted, right-click to show a menu, and select ‘properties’. 

In the properties window, the ID is currently set to ‘101’.  We need to change this to ‘001’.   
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In the executable tree view, it will have ‘1’ for the identifier, but the internal ID number remains ‘001’, as listed in 

the properties window. 

 
 

Use CTRL+S or right-click on the ‘sombreros.exe’ tab and use the drop-down menu to save ‘sombreros.exe’. 
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Repeat the icon import and rename process for the 5 additional icons matching the descriptions from the Variables section 

1  For IE7, IE8, IE9, IE10, and IE11, this value is used for HotIcon and Icon sources 
   For IE6, on Windows XP, this is used for Icon value for Toolbar Button  (ID = 001) 
 
2  For IE6, on Windows XP, this is used for HotIcon value for Toolbar Button  (ID = 002) 
 
3  For Windows 2000, IE 5.5 or 6, this is used for Icon  (ID = 003) 
 
4  For Windows 2000, IE 5.5 or 6, this is used for HotIcon  (Mouse is over Toolbar Button)  (ID = 004) 
 
5  For Windows 98, Me, or NT, this is used for Icon value for Toolbar Button  (ID = 005) 
 
6  For Windows 98, Me, or NT, this is used for HotIcon (Mouse is over Toolbar Button)  (ID = 006) 

 

 

Once the .exe has been saved using Visual Studio, the program can be tested. 

If the solution or project is compiled without a compatibility section, the following warning message may be 

encountered in Windows Vista or Windows 7: 

 
 

The compatibility section belongs in the middle of the app.manifest file, in the My Project folder, but the VS 

2005 version included in this package does not include it: 

<compatibility xmlns="urn:schemas-microsoft-com:compatibility.v1"> 

  <application> 

   <!-- A list of all Windows versions that this application is designed to work with. 

Windows will automatically select the most compatible environment.--> 

      <!-- Windows 10 --> 

      <supportedOS Id="{8e0f7a12-bfb3-4fe8-b9a5-48fd50a15a9a}"/>       

      <!-- The ID below indicates application support for Windows 8.1 --> 

      <supportedOS Id="{1f676c76-80e1-4239-95bb-83d0f6d0da78}"/> 

      <!-- The ID below indicates application support for Windows Vista --> 

      <supportedOS Id="{e2011457-1546-43c5-a5fe-008deee3d3f0}" /> 

      <!-- The ID below indicates application support for Windows 7 --> 

      <supportedOS Id="{35138b9a-5d96-4fbd-8e2d-a2440225f93a}" /> 

      <!-- The ID below indicates application support for Windows 8 --> 
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      <supportedOS Id="{4a2f28e3-53b9-4441-ba9c-d69d4a4a6e38}" /> 

  </application> 

 </compatibility>  
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Please send questions or concerns regarding this document to documents@firstbutton.com. 

 

 

 

NO WARRANTIES.  Liquidity Lighthouse, LLC expressly disclaims any warranty for the SOFTWARE PRODUCT .  THE 

SOFTWARE PRODUCT AND ANY RELATED DOCUMENTATION IS PROVIDED  "AS IS" WITHOUT WARRANTY OF 

ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT.   

Limitation of Liability 

To the maximum extent permitted by applicable law, in no event shall Liquidity Lighthouse, LLC or its suppliers be liable 

for any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss 

of business profits, business interruption, loss of business information, or any other pecuniary loss)  arising out of the use 

of or inability to use the SOFTWARE PRODUCT or the provision of or failure to provide Support Services.  

By using the Installation Software, you agree not to assert any intellectual property rights, including but not limited to, 

claims of trademark infringement, against Liquidity Lighthouse, LLC  or its suppliers, now or in the future. 

 

 

 

 

Liquidity Lighthouse, LLC 

PO Box 211091 

Bedford, TX 76095 

 

 

 

 

 
 

 

FirstButton and Liquidity Lighthouse are trademarks of Liquidity Lighthouse, LLC. 

 

mailto:documents@firstbutton.com

